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Kit Contents
 Cap Color  Reagents 12 tests 24 tests 48 tests 

1 BROWN HIV-1 Reaction Mix 407 μl 629 μl 1073 μl

2 YELLOWYELLOW HIV-1 Enzyme Mix 33 μl 51 μl 87 μl

3 BLUE HIV-1 Internal Control 1 tube 1 tube 1 tube

4 RED HIV-1 Quantification Standard 1 (107 IU/ml) 1 tube 1 tube 1 tube

5 RED HIV-1 Quantification Standard 2 (106 IU/ml) 1 tube 1 tube 1 tube

6 RED HIV-1 Quantification Standard 3 (105 IU/ml) 1 tube 1 tube 1 tube

7 RED HIV-1 Quantification Standard 4 (104 IU/ml) 1 tube 1 tube 1 tube

8 WHITE PCR Grade Water 1 tube 1 tube 1 tube

Storage
All reagents of RTA HIV-1 Real-Time PCR Kit should be stored at -20°C. Storage at higher temperatures should 

be avoided (e.g. +4°C). Under these conditions, kit contents should be stable through the expiration date printed 

on the label.  The reagents should not be freeze-thawed more than 2 times; otherwise the shelf of the kit will 

reduce. During the working steps all reagents should be kept on ice. 



Intended 
Use

RTA HIV-1 Real-Time PCR Kit is an in vitro nucleic acid amplification assay for quantification of  Human 

Immunodeficiency virus type 1 (HIV-1) RNA  in human serum or plasma (EDTA) using RTA VOLTRAN Viral Load 

Detection System (HAMILTON Microlab STARlet IVD and BIO-RAD CFX96-IVD Real-Time PCR Detection 

System).  RTA HIV-1 Real-Time PCR Kit is intended for use as an aid in the management of patients with 

chronic HIV-1 infection undergoing anti-viral therapy to assess response to treatment in conjunction with all 

relevant clinical and laboratory findings. RTA HIV-1 Real-Time PCR Kit is not intended for screening of blood 

and blood products for the presence of HIV-1 RNA or confirmation of the diagnosis of infection with HIV-1.
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Product Use 
Limitations

All reagents of the kit is for in vitro diagnostic use only.

RTA HIV-1 Real-Time PCR Kit is not intended for screening of blood and blood products for the presence of HIV-1 

RNA or confirmation of the diagnosis of infection with HIV-1.

This kit has been validated for use with human serum or human plasma collected in EDTA anticoagulant. Test with 

other sample types may result in inaccurate results.

This kit has been validated for use with RTA VOLTRAN Viral Load Detection System (HAMILTON Microlab 

STARlet IVD and BIO-RAD CFX96-IVD Real-Time PCR Detection System). Using other instruments may 

adversely affect the performance characteristics of the kit.

This kit has been optimized for use with specific PCR plastic consumables listed under Additional Materials 

Required section of the Handbook. Using other PCR plastic consumables may adversely affect the performance 

characteristics of the kit.  

Trustworthy results depends on proper sample collection, transport, storage and processing methods.

It is intended for professional use by properly trained personnel. 

RTA HIV-1 Real-Time PCR Kit is  intended for use as an aid in the management of patients with chronic HIV-1 

infection undergoing anti-viral therapy to assess response to treatment in conjunction with all relevant clinical and 

laboratory findings.

The instructions in user manual should be followed strictly for optimum PCR results.

The expired kits should not be used. Kit components from different lots should not be mixed.

 



RTA HIV-1 Real-Time PCR assay is a one-step real time reverse transcription PCR assay in which RNA 

templates are first reverse-transcribed to generate complementary cDNA strands followed by DNA polymerase-

mediated cDNA amplification. During cDNA replication in the PCR process, the internal oligonucleotide 

hybridizes to the template and is digested by the 5'-3' endonuclease activity of the Thermus aquaticus (Taq) 

DNA polymerase as the PCR primer is extended. The internal oligonucleotide is digested only if cDNA 

replication occurs, separating the fluorescent and quencher molecules. PCR products are detected within 

minutes by monitoring the increase in fluorescence that occurs exponentially with successive PCR amplification 

cycles.  The parameter Ct (threshold cycle) is defined as the fractional cycle number at which the fluorescence 

passes the fixed threshold. A plot of the log of initial target copy number for a set of standards versus Ct is a 

straight line. Quantification of the amount of target in unknown samples is accomplished by measuring Ct and 

using the standard curve to determine starting copy number. RTA HIV-1 real-time PCR assay utilizes external 

standards to gather quantitative results and includes an internal control, which controls for target isolation and 

amplification. The target region is situated in gag gene region of HIV-1 genome and is 121-bases long. HIV-1 

RNA concentration is noted in International Units/ml (IU/ml). If it is needed to convert to copies/ml, our 

conversion factor for RTA HIV-1 Real-Time PCR Kit is 0.5 copies/IU. In other words, 1 IU/ml = 0.5 copies/ml.

Product 
Description
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Pathogen 
Information

HIV is classified in the family Retroviridae, subfamily Lentivirinae, and genus Lentivirus (1). The structure of HIV 

follows the typical pattern of the retrovirus family, comprising a singlestranded, positive-sense ribonucleic acid 

(RNA) genome of about 9.7 kilobases. There are two strands of HIV RNA and each strand has a copy of the 

virus’s nine genes. The RNA is surrounded by a cone-shaped capsid which consists of approximately 2000 

copies of the p24 viral protein. Surrounding the capsid is the viral envelope. The viral envelope is composed of a 

lipid bilayer membrane, formed from the cellular membraneof the host cell during budding of the newly formed 

virus particle. Host-cell proteins, such as the major histocompatibility complex (MHC) antigens and actin, remain 

embedded within the viral envelope, along with the viral envelope protein. Each envelope subunit consists of 

two non-covalently linked membrane proteins: glycoprotein (gp) 120, the outer envelope protein, and gp41, the 

transmembrane protein that anchors the glycoprotein complex to the surface of the virion. The envelope protein 

is the most variable component of HIV, although gp120 itself is structurally divided into highly variable (V) and 

more constant (C) regions. The variability of V regions may be a product of envelope functionality, as has been 

especially well described in V3, where amino acid changes alter coreceptor use. The variability of the HIV 

envelope also confers a uniquely complex antigenic diversity (1). 

HIV-1 is divided into three quite distinct lineages: the groups M, N and O. Again, the worldwide distribution of 

these groups is not equal: group M (for Main) strains are substantially more common in the global epidemic than 

the group O (Outlier) strains, which are largely confined to Africa, with sporadic cases reported elsewhere. The 

group N (non-M, non-O) strains have only been isolated in Cameroon (2).

References
1.  Chiu IM, Yaniv A, Dahlberg JE, Gazit A, Skuntz SF, Tronick SR, et al. Nucleotide sequence evidence for 
relationship of AIDS retrovirus to lentiviruses. Nature 1985;317(6035):366-8.
2.  Simon F, Mauclere P, Roques P, Loussert-Ajaka I, Muller- Trutwin MC, Saragosti S, et al. Identification of a 
new human immunodeficiency virus type 1 distinct from group M and group O. Nat Med 1998;4(9):1032-7.



Warnings and 
Precautions
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All clinical specimens and all resulting waste materials should be treated as potentially infectious; the samples 

should be prepared in Bio-safety Level 2 area . 

Before and after work all surfaces should be disinfected with a freshly prepared solution of 10% bleach or 

antiviral agents.

Dispose of unused reagents, waste and specimens in accordance with country or local regulations.

Do not pipette by mouth.

Do not eat, drink or smoke in laboratory work areas.

Wear protective disposable gloves, laboratory coats and eye-wear when handling clinical specimens and kit 

reagents. Wash hands thoroughly after handling specimens and test reagents.

Avoid contact of reagents with the skin, eyes or mucous membranes. If contact does occur, immediately wash 

with large amounts of water,

Use all pipetting devices and instruments with care and follow the manufacturer’s

instructions for calibration and quality control; to prevent sample contamination, use new, sterile aerosol barrier 

or positive displacement RNase-free pipette tips and sterile pipettes

Handle all materials containing specimens or controls according to Good Laboratory Practices in order to 

prevent cross-contamination of specimens or controls.

Store the kit away from any source of contaminating DNA or RNA, especially amplified nucleic acid.

Do not mix reagents with different lot numbers or substitute reagents from other manufacturers.

A single type of HIV-1 RNA assay should be used for monitoring a patient. If RTA HIV-1 Real-Time PCR Kit 

substitutes another HIV-1 RNA assay, both tests should be used in parallel for at least two subsequent samples.

Do not use a kit after its expiration date.
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Additional 
Materials 
Required

●  RTA VOLTRAN Viral Load Detection System components:

●HAMILTON Microlab STARlet IVD (Cat. No:185011) 

●BIO-RAD CFX96-IVD Real-Time PCR Detection System (Cat. No:1855095-IVD)

●RTA MB Viral Nucleic Acid Isolation Kit (Cat. No: 090150XX)

●HAMILTON High Vol. (1mL) CO-RE Tips, Filtered 1000ul tips with filters (Cat. No:235905)

●HAMILTON Std. Vol. (300uL) CO-RE Tips, Filtered 300ul tips with filters (Cat. No:235903)

●HAMILTON DEEP WELL PLATE PP 2.2ML BC (Cat. No:235656)

●HAMILTON Reagent Containers, 60ML (Cat. No:194051)

●HAMILTON Reagent Containers, 2000ML (Cat. No:56695-01)

●BIO-RAD Hard-Shell Thin-Wall 96-Well Skirted PCR Plates with Bar Codes (Cat. No:HSP-9955)

●BIO-RAD Microseal 'B' Adhesive Seals, optically clear (Cat. No:MSB-1001)

● Disposable powder-free gloves

● Micropipettes (0.5 µl – 1000 µl) 

● Sterile micropipette  tips with filters

● Vortex mixer 

● Desktop microcentrifuge for 2.0 ml tubes and for PCR plates



Sample 
Preparation

This kit has been validated for use with human serum or human plasma collected in EDTA anticoagulant.

Aseptic techniques must be employed during collection to prevent the introduction of micro-organisms into the 

patient’s anatomical space, and to prevent the sample from being contaminated during the process of collection.

All samples should be regarded as potentially infectious and standard precautions guidelines should be followed 

by all healthcare workers during sample collection and handling.

Samples must be collected into appropriate containers before despatch to the laboratory. Formats accepted are 

4ml and 7ml Vacutainers (BD #368861 and #367864) or similar tubes that do have the same inner dimensions 

as these two tubes (round-bottom and inner diameter).

Be careful to check for cracks in the containers and to ensure that the lids of containers are properly tightened 

to prevent leakage of samples during handling and transportation. This can pose infection hazards to transport 

and laboratory staff.

Ensure that the outer surfaces of the containers are not contaminated by the patients’ samples.

Store whole blood at room temperature  for no longer than 4 hours. Centrifuge blood within 4 hours of collection. 

Transportation of whole blood, serum or plasma must conform to country or local regulations for the transport of 

etiologic agents.

Serum or plasma samples may be stored at 2-8°C for up to 3 days or frozen at -70°C or

colder for long-term storage.

Avoid multiple freeze/thaw cycles of specimens.
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Protocol Viral RNA Isolation 

RTA VOLTRAN Viral Load Detection System should be used together with RTA MB Viral Nucleic Acid Isolation 
Kit (Cat. No: 090150XX) for viral RNA extraction from clinical samples. Starting sample volumes were 200 μl and 
elution volumes were 50 μl. Please follow the manufacturer’s instructions as stated in RTA VOLTRAN Viral Load 
Detection System Handbook.

 Internal Control 

During RNA isolation, addition of the supplied internal control (IC) is necessary. IC allows the user to monitor 
RNA extraction step as well as to determine any PCR inhibition. There was no amplification of internal control in 
the tests where  high positive HIV-1 samples were amplified because there was a competition between internal 
control template and HIV-1 RNA template for using PCR primers and other components. The Ct value of internal 
control of a negative sample should be equal to 33 ± 5, otherwise,it denotes a problem during purification.

Quantification Standards

For generating a standard curve to obtain accurate quantification data on the Real-Time system, four 
quantification standards should be used. For each standard the corresponding concentration should be defined 
properly to the Real-Time PCR system before each run and the standard curve will be generated accordingly at 
the end of the reaction.

Since starting sample volumes were 200 μl and elution volumes were 50 μl, the concentration factor is 4. If we 
define the corresponding concentration for each standard by dividing the original concentration by 4, the 
concentration of each positive sample will be automatically calculated by CFX Manager software. The 
concentrations of the standards are already defined either in plate file (.pltd extension) under Templates folder 
for manual programming or in LIMS file generated by HAMILTON Microlab STARlet IVD.

PCR Setup

RTA VOLTRAN Viral Load Detection System should be used together with RTA HIV-1 Real-Time PCR Kit (Cat. 
No: 090130XX) for setting up PCR reactions. Four quantification standards and one negative control should be 
included for every run. Please follow the manufacturer’s instructions as stated in RTA VOLTRAN Viral Load 
Detection System Handbook.
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Protocol 
(continued)

Running Assay on BIO-RAD CFX96-IVD Real-Time PCR Detection System by Manual Programming

Close the PCR plate with BIO-RAD Microseal 'B' Adhesive Seal, and place it in the 96-well block. Close the lid.
The Startup Wizard automatically appears when Bio-Rad CFX Manager software is first opened. If it is not 
shown, click the Startup Wizard button on the main software window toolbar. Click User-defined option in the 
Startup Wizard (Figure 1).

Figure 1. Startup Wizard window.
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Protocol 
(continued) Click the Protocol tab and then click the Select Existing tab to select RTA HIV-1 Real-Time PCR Kit protocol file 

(.prcl extension) under Templates folder to run (Figure 2).

Figure 2. Protocol selection window.
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Protocol 
(continued) Then click the Plate tab and then click the Select Existing tab to select RTA HIV-1 Real-Time PCR Kit plate file 

(.pltd extension) under Templates folder to load. Then edit the plate according to the test number and sample 
information by clicking Edit Selected option (Figure 3).

Figure 3. Plate selection window.
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Protocol 
(continued) Click the Start Run tab and then click the Start Run button to begin the experiment.(Figure 4).

Figure 4. Start Run window.
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Protocol 
(continued)

Running Assay on BIO-RAD CFX96-IVD Real-Time PCR Detection System by LIMS Integration

CFX Manager software can be configured for use with a Laboratory Information Management System (LIMS). 
For LIMS integration, CFX Manager software requires plate setup information generated by HAMILTON Microlab 
STARlet IVD (a LIMS file, *.plrn), a protocol file created using CFX Manager software (*.prcl), a defined data 
export location, and a defined export format.

Setting up LIMS Folder and Data Export Options
1. Select Tools > Options from the main software menu bar then select the LIMS tab (Figure 5) to define the 
folder location that will contain the LIMS protocol (*.prcl), LIMS file (*.plrn), and exported data.

Figure 5. Options window displaying the LIMS settings tab.
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Protocol 
(continued)

2. At run completion, a LIMS data export file can be automatically generated in addition to the CFX Manager 

software *.pcrd data file. Check the Automatically Export Data after Run (Figure 5) box to have the data 

exported automatically once a run is completed.

3. Click the Data Export Settings button to specify the file format to be used for the exported data and which 
information fields will be exported (Figure 6).

Figure 6. LIMS Data Export Format Settings window.
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Protocol 
(continued)

Creating a LIMS Protocol

To start a LIMS run, a CFX Manager software protocol file (*.prcl) must be created and saved in the designated 

LIMS protocol folder location specified in the LIMS tab of the Options window.

Creating a LIMS File

A LIMS file (*.plrn) contains the plate setup details and the protocol file name. This file is generated by 

HAMILTON Microlab STARlet IVD (a LIMS file, *.plrn). CFX Manager software will use the LIMS file to create a 

plate file that will be used in conjunction with the named protocol file to start a run and generate data.
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Protocol 
(continued)

Initiating a LIMS Run
Close the PCR plate with BIO-RAD Microseal 'B' Adhesive Seal, and place it in the 96-well block. Close the lid.
To initiate a LIMS run:
1. Open a LIMS file using one of the following methods:
• Drag and drop the .plrn file onto the CFX Manager software window or desktop icon
• Select Tools > LIMS File Folder from the main software window menu bar. Double-click on the desired .plrn 
file to open the run
• Select File > Open > LIMS file from the main software window menu bar. Select the .plrn file from the LIMS 
folder and click Open
2. To start the run for a selected LIMS file, select an instrument and click Start Run (Figure 7). The contents of 
the LIMS file and linked protocol file are used to complete the protocol and plate tabs.
Figure 7. Run Setup window with a LIMS run ready to start.
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Protocol 
(continued)

Exporting Data to a LIMS

Upon run completion, a CFX Manager software data (.pcrd) file is generated and saved to the defined data 

export folder location (Figure 5).

When Automatically Export Data after Run is selected in LIMS Options, a second data file compatible with 

LIMS data retrieval will be saved to the same location. The file format and contents are defined using LIMS Data 

Export Format settings. To export this data manually, select Export > Export to LIMS Folder from the main 

software window menu bar.
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Data Analysis To be able to evaluate the experiment, PCR efficiency of the Standard Curve must be between 90%-110% and R2 

value must be more than 0.98. Otherwise, the experiment should be repeated.For analysis, adjust baseline threshold 

as selecting “auto threshold” option. (In the laboratories that RTA VOLTRAN Viral Load Detection System is 

installed, FAM and HEX values are pre-adjusted on CFX Manager, user do not adjust manually).Then, the 

concentration of each sample will be calculated by the CFX Manager software according to the standard curve as 

International Unit permilliliter  (IU/ml). If it is needed to convert the quantitative results from IU/ml to copies/ml, the 

conversion factor for RTA HIV-1 Real-Time PCR Kit, version 2.0 is 0.5 copies/IU. In other words, 1 IU/ml = 0.5 

copies/ml.

The interpretation on the results given by the software can be done as follows:
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Signal detected
İn FAM channel

Signal detected
İn HEX channel

Quantitative result
from the software

Conclusion

+ + <83 IU/ml The result is valid.
HIV-1 RNA is detected at a concentration <83 IU/ml. 
Quantitation is not possible since the quantitative result is 
below the analytical sensitivity value of the assay. 
Reproducibility of the positive result is not guaranteed.

+ +/- ≥83 IU/ml

and

≤1 x 109 IU/ml

The result is valid.
HIV-1 RNA is detected at the concentration calculated by the 
software since the quantitative result is within the linear range 
of the assay.

+ +/- >1 x 109 IU/ml The result is valid.
HIV-1 RNA is detected at a concentration >1 x 109 IU/ml . 
Quantitation is not possible since the quantitative result is 
above the linear range of the assay.

- + N/A The result is valid.
Target (HIV-1 RNA) is not detected.

- - N/A The result is invalid.
No diagnostic interpretation can be done.



Performance 
Characteristics

Analytical Sensitivity

Analytical sensitivity was analyzed by use of a dilution series of WHO standard, and the cutoff value of the kit 

was determined by probit analysis for BIO-RAD CFX96-IVD Real-Time PCR Detection System. A dilution series 

of a WHO International HIV-1 standard (NIBSC code: 10/152) was prepared to give the final concentrations of 

640, 320, 160, 80, 40 and 20 IU/ml. Dilutions were extracted by RTA VOLTRAN Viral Load Detection System  

according to the instructions written in the handbook. Starting sample volumes were 200 µl and elution volumes 

were 50 µl. Each dilution was tested in 24 replicates. Lower limit was calculated by probit analysis done by 

PASW Statistics 18 program. RTA HIV-1 Real-Time PCR Kit, version 2.0 can detect HIV-1 RNA at concentration 

of 68 IU/ml with a probability rate of 95 %. And, 95 % confidence range is 51,7 –122,5 IU/ml.
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Performance 
Characteristics
(continued)

Linear Range

To determine the upper limit, a dilution series of RTA HIV-1 Reference Material (Genotype B) ranging from 1 x 

104 IU/ml to 1 x 106 IU/ml were prepared. High concentration samples (1 x 107, 1 x 108 and 1 x 109 IU/ml) were 

prepared by using calibrated in vitro transcribed RNA bearing HIV-1 quantification standard. Viral RNA was 

extracted from standards by RTA Automated DNA/RNA Preparation and PCR Setup System  according to the 

instructions written in the handbook. Starting sample volumes were 200 µl and elution volumes were 50 µl.  

Within this range, the relationship between log of target RNA and Ct values is linear. Linear regression analyses 

comparing the Ct values-versus- log of target RNA  were as follows:  

Ct value = -3.342(log of target RNA) + 45.27; with a correlation coefficient (R2) of 0.998.

Upper limit is at least 1 x 109 IU/ml for  BIO-RAD CFX96-IVD Real-Time PCR Detection System.

Lower limit was calculated by probit analysis done by PASW Statistics 18 program according to the 

quantification results of HIV-1 Analytical Sensitivity Studies.  95 % lower confidence limit is 83 IU/ml for BIO-

RAD CFX96-IVD Real-Time PCR Detection System. Dynamic range of RTA HIV-1 Real-Time PCR Kit: 

83 - 1 x 109 IU/ml
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Performance 
Characteristics

Precision

For each experiment, 24 replicates of each concentration of 5x105 and 5x102 IU/ml of RTA HIV-1 Reference 

Genotype B calibrated with 3rd WHO International Standard   (NIBSC code: 10/152) were used. The results on 

basis of log values are shown in the following tables:
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Table 1: Descriptive statistics of HIV-1 precision data for 5x105 IU/ml sample.

N Minimum Maximum Mean Std. Deviation Variance Coefficient of 
variation (%)

Intra_assay 24 5,55 5,76 5,6767 ,04887 ,002 0,86

Inter_assay 24 5,61 5,77 5,6846 ,03741 ,001 0,66

Inter_batch 24 5,52 5,82 5,7554 ,05710 ,003 0,99

Inceptra 24 4,69 6,03 5,7108 ,23756 ,056 4,16

Stratagene 24 5,68 5,76 5,7325 ,02770 ,001 0,48

RotorGene 24 5,69 5,80 5,7608 ,02636 ,001 0,46

VOLTRAN 24 5,45 5,76 5,6083 ,07631 ,006 1,36

TOTAL 168 4,69 6,03 5,7042 ,11041 ,012 1,94



Performance 
Characteristics

Precision
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Table 2: Descriptive statistics of HIV-1 precision data for 500 IU/ml sample.

N Minimum Maximum Mean Std. Deviation Variance Coefficient of 
variation (%)

Intra_assay 24 2,46 2,99 2,7513 ,12088 ,015 4,39

Inter_assay 24 2,31 2,88 2,7425 ,12400 ,015 4,52

Inter_batch 24 2,37 2,93 2,6525 ,14161 ,020 5,34

Inceptra 24 2,51 3,13 2,7521 ,15013 ,023 5,46

Stratagene 24 2,53 2,84 2,6700 ,09278 ,009 3,48

RotorGene 24 2,54 2,84 2,7358 ,06157 ,004 2,25

VOLTRAN 24 2,43 2,96 2,7467 ,14666 0,22 5,34

TOTAL 168 2,31 3,13 2,7215 ,12719 ,016 4,67



Performance 
Characteristics
(continued)

Genotype Detectability

The performance of RTA HIV-1 Real-Time PCR Kit was evaluated with 2nd WHO International Reference Panel 

Preparation for HIV-1 Subtypes for NAT (Main) (NIBSC code: 12/224) and 1st WHO International Reference 

Preparation for HIV-1 CRF's (NIBSC code: 13/214). The data gathered by RTA HIV-1 Real-Time PCR Kit is 

compatible with the results of the WHO ECBS reports. As a result of this study, RTA HIV-1 Real-Time PCR Kit 

can detect and quantify all subtypes of HIV-1 M group and Circulating Recombinant Forms.

Diagnostic Specificity

HIV-1 negative clinical specimens were analyzed to determine the diagnostic specificity of RTA HIV-1 Real-Time 

PCR Kit. 54 HIV-1 RNA negative clinical serum specimens and 52 HIV-1 RNA negative clinical EDTA plasma 

specimens were used. Viral RNA was extracted from HIV-1 negative clinical specimens  by RTA VOLTRAN Viral 

Load Detection System  according to the instructions written in the handbook. 

None of the  HIV-1 negative clinical specimens gave positive test result for HIV-1 RNA. Diagnostic specificity of 

RTA HIV-1 Real-Time PCR Kit is 100 %.  All of the Internal Controls of tests gave positive result. 
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Performance 
Characteristics

Cross Reactivity

To examine the specificity of an assay, cross-reactivity studies should be performed for potential cross-reactive 
markers. In this study, the specificity  of the assay was evaluated  by  testing 7 reference organism and 9 clinical 
specimens which were positive. RTA HIV-1 Real-Time PCR Kit do not show any cross-reactivity with other 
potential cross-reactive markers given in the table below:
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Organism Source Test Result

HCV for NAT (4th WHO International Standard) NIBSC Code: 06/102 Negative

1st WHO International Standard for EBV for NAT NIBSC Code: 09/260 Negative

1st WHO International Standard for HCMV for NAT NIBSC Code: 09/162 Negative

3rd WHO International Standard for HBV for NAT NIBSC Code: 10/264 Negative

Human Herpes Simplex virus type 2 for Nucleic Acid 
Amplification Techniques

NIBSC Code: 08/226 Negative

Human Herpes Simplex virus type 1 for Nucleic Acid 
Amplification Techniques

NIBSC Code: 08/224 Negative

Varicella Zoster Virus(Type B) Working Reagent for 
Nucleic Acid Amplification Testing (NAT)

NIBSC Code: 08/310 Negative

HTLV-1 (13 samples) 13 Clinical specimens Negative



Performance 
Characteristics
(continued)

Cross-Contamination

In this study, cross-contamination between samples was evaluated. To do this, five different runs were 

performed. In every run, 4 high positive HIV-1 sample and 4 HIV-1 negative samples were used. Samples were 

extracted by RTA VOLTRAN Viral Load Detection System according to the instructions written in the handbook. 

Starting sample volumes were 200 µl and elution volumes were 50 µl. Then, the kit was evaluated accordingly 

whether or not any  cross-contamination was observed.

No cross-contamination was observed during the whole process, and none of the human serum samples 

exhibited evidence of containing PCR inhibitors as indicated by the amplification of internal control.

Whole System Failure

50 HIV-1 RNA negative clinical serum specimens and 50 HIV-1 RNA negative clinical EDTA plasma specimens 

were spiked with WHO International Standard 3rd HIV-1 International Standard (NIBSC code: 10/152) to give a 

final concentrations of 204 IU/ml which is 3 times the 95% positive cutoff value determined by analytical 

sensitivity study. Spikes were extracted  by RTA VOLTRAN Viral Load Detection System according to the 

instructions written in the handbook. Whole  system  failure  rate of RTA HIV-1 Real-Time PCR Kit is ≤1 %.

Clinical Comparative Study

Total 199 clinical samples were tested. 107 of the specimens were positive, and the rest of them were negative.. 

According to the results, the data gathered by RTA HIV-1Real-Time PCR Kit is compatible with the results of 

other CE-marked devices. Log concentrations of all of 107 positive clinical samples are between ±1 log 

concentrations of the result of comparative device.
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RTA Laboratuvarları
Biyolojik Ürünler İlaç ve Makine San. Tic. A.Ş.
Plastikçiler Organize Sanayi Bölgesi
Cumhuriyet Cad. No:3 41400
Gebze / Kocaeli /Türkiye
Phone: +90 262 648 5300 
Fax: +90 262 751 0677 
E-mail: rta@rtalabs.com.tr 
Web: www.rtalabs.com.tr

RTA.KK.077 Revision Date/Revision No: 14.11.2016/9


	Slide 1
	Slide 2
	Slide 3
	Slide 4
	Slide 5
	Slide 6
	Slide 7
	Slide 8
	Slide 9
	Slide 10
	Slide 11
	Slide 12
	Slide 13
	Slide 14
	Slide 15
	Slide 16
	Slide 17
	Slide 18
	Slide 19
	Slide 20
	Slide 21
	Slide 22
	Slide 23
	Slide 24
	Slide 25
	Slide 26
	Slide 27
	Slide 28
	Slide 29
	Slide 30

